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Ques. 1. What are the skills a finance special-
ized student should have?

Traditionally, a finance student was
expected to be well versed in knowing the vari-
ous financial tools to carry on the work in hand.
He/she had to execute the job within the iron
boundaries of financial management. Now, fi-
nance has also attracted innovative ideas. The
finance student should have the capability to take
decisions which are beyond the text books and
now more pertinently, beyond the ‘Google search
engine’. If a finance student is aware of the hap-
penings in the global scenario he/she is likely to
provide solutions to seemingly ‘systemic prob-
lems’. Use of web and networking allows the
student to do that.

Ques. 2. What all are the areas where general-
ly student lack and should focus upon?

The students generally lack the expo-
sure to ‘unforeseen financial situations’ and are
found to be unaware to the remedies available.
The solution to these issues is that the students
should be clear in their mind as to ‘what do they
stand for, what is their ultimate aim’. For that,
students should have more policy oriented read-
ings and case studies at their disposal.

Ques. 3. How would you describe the picture
across the region in terms of the global finan-
cial crisis?

The global scenario post financial crisis
has been that of ‘cautious optimism’ but the
speed of reforms is fairly slow. The resistance
from U.S. congress to pursue further state run
programs seems to have given a jolt to the mar-
ket sentiments. However, given the strong funda-
mentals of Indian economy and timely interven-
tions from financial apex bodies like RBI, IRDA,
SEBI et al, we are much better placed as com-
pared to U.S.A. and East European countries.
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Ques. 4. What is the relationship be-
tween risk and return?

The relationship between risk
and return is that they both are positively
correlated. One cannot expect high returns
if the risks are low. If, however, big re-
turns are realized in ventures where risk
was appreciably lower, then it has to ei-
ther a case of ‘information imperfections’
or that of ‘sealed entry’ causing such a
win-win situation to investor/business
person.

Ques. 5. Scope of finance as a career
choice ?

Finance has tremendous scope in
the time to come. What I foresee is that
‘Finance’ as a discipline would be supple-
mented with host of other disciplines/
tools such as Information Technology,
Risk Management tools.
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1.Billionaire Mark Cuban:
shortcuts.

work. Out-think. Out-sell your expectations. There
are no shortcuts." The advice came from his father,
who did upholstery on cars, when Cuban was in
high school. "He was always very encouraging but
also realistic,”" Cuban says of his dad.

2.Entrepreneur and author Tim Ferriss: You are
who you associate with.

W -~
"The best advice I ever got is: You’re the average of
the five people you associate with the most," Ferriss,
author of the best-selling book ".He got the advice
from a wrestling coach when he was in high school,
and has never forgotten it. "I use it always, whether
it’s choosing startups to invest in, choosing inves-
tors, sports teams to join, or people to have dinner
with. Constantly, I think about this."

: TIPS FOR ACHIEVING
ENTERPRENEURIAL SUCCESS

There are no

The best advice he ever got was: "Do the work. Out-
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3.Hello Design CEO David Lai: Your time is a
precious commodity.

"When I was growing up my father would always
tell me, "We all only have 24 hours a day. It's what
we choose to do with that time that defines us, It's
the one thing you can never get back."

4.Real estate mogul Barbara Corcoran: My
best advice was an insult.

Call it reverse psychology, but it was an insult that
motivated Corcoran to succeed. "It's kind of weird.
The best advice was the worst advice. It was from
my boyfriend and partner in my first business
when he told me I would never succeed without
him. I was injured no doubt. But thank God he in-
sulted me because I would not have built a big
business without that. It kept me trying everything
because I couldn't give him the satisfaction of see-
ing me fail. So the best advice was an insult."

FINJOB
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1.The average age of P, Q, R and S is 30 years. How
oldis R?

I. The sum of ages of P and R is 60 years.
IL. S is 10 years younger than R.

A. T alone sufficient while II alone not sufficient to
answer

B. II alone sufficient while I alone not sufficient to
answer

C. Either I or II alone sufficient to answer
D. Both I and II are not sufficient to answer

E. Both I and II are necessary to answer
Explanation: P+Q+R+S=(30x4)
= P+Q+R+S=120...()
I.P+R=60... (i)
IL S=(R-10) .... (iii)
From (i), (ii) and (iii), we cannot find R.

Hence, the correct answer is (D)

2.How many candidates were interviewed everyday
by the panel A out of the three panels A, B and C?

I. The three panels on average interview 15 can-
didates every day.

discounting it to the present value is ................. .

amounts.

FREQUENTLY ASKED QUESTIONS |

1. A future amount that has been discounted to time period 0 becomes a

....... of interest.

3. The name associated with the amount removed from a future value when

4. In the calculation of present values, the future amounts that are discounted
are not accrual accounting amounts; rather they are future

Aptitude Test

Are you ready?

IT. Out of a total of 45 candidates interviewed eve-
ryday by the three panels, the number of candidates
interviewed by panel A is more by 2 than the can-
didates interviewed by panel ¢ and is more by 1
than the candidates interviewed by panel B.

A. T alone sufficient while II alone not sufficient to
answer

B. II alone sufficient while I alone not sufficient
to answer

C. Either I or II alone sufficient to answer
D. Both I and II are not sufficient to answer

E. Both I and II are necessary to answer

Explanation: 1. Total candidates interviewed by 3
panels = (15 x 3) =45.

II. Let x candidates be interviewed by C.
Number of candidates interviewed by A = (x + 2).
Number of candidates interviewed by B = (x + 1).
x+(x+2)+(x+1)=45
= 3x=42
=~ x=14

Hence, the correct answer is (B).
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74| Excel 2010
=) Working with Sparklines

Creating Sparklines

Sparklines were intfroduced in Excel 2010 to be a convenient s
alternative to charts. Unlike a traditional chart, a sparkline is
placed inside a cell, allowing you to easily create a large
number of sparklines (for example, one on each row).

Types of Sparklines

' EXCEL WITH MS-EXCEL

There are three different types of sparklines: Line, Column, and Win/Loss. Line and Column work the same as
line and column charts. Win/Loss is similar to Column, except it only shows whether each value is positive or
negative, instead of how high or low the values are. All three types can display markers at important points, such

as the highest and lowest points, to make them easier to read.
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To Create Sparklines:

Generally, you will have one sparkline for each row, but you can create as many as you want in any location you
want. Just like with formulas, it's usually easiest to create a single sparkline and then use the fill handle to

automatically create the sparklines for the remaining rows.

1. Select the cells that you will need for the first sparkline. In this example, we are creating a sparkline for Kathy

Albertson, so we will select her sales data.

Albertson, Kathy $3,947.00  $557.00  $3,863.00 $1,117.00  $8,237.00  $8,690,A]
Allenson, Carol 51,411.00 51,042.00  $9,355.00 $1,100.00  510,185.00  518,749.00
Altman, Zoey §2,521.00 53,072.00  $6,702.00 $2,116.00 $13,452.00  58,046.00

Selecting cells

2. Click the Insert tab.

3. Inthe Sparklines group, select Line. A dialog box will appear.

Line = a
Column — o
Slicer | Hyperlink Text
" Win/Loss Box
Sparklines Filter Links
Insert Line Sparkline
Insert a line chart within a single ]

cell.

The Line command

4. Make sure the insertion point is next to Location Range.

FINJOB
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:_ EXCEL WITH MS-EXCEL

5. Click the cell where you want the sparkline to be. In this example, we'll select the cell to the right of the selected

cells.

F G H 1
$8,237.00 $8,690.00 -

$10,185.00 $18,749.00
$13,452.00 $8,046.00
$4,404.00 $20,114.00
$3,170.00 $10,733.00

Select the cell
where you want the
sparkline to be.

Create Sparklines

Choase the data that you want

%8,817.00 $18,524.00 Ee T 7=G2
$13,090.00 $13,953.00
$3.528.00 $15.275.00 Choose where you want the sparklines to be placed

$4,839.00 <13,085.00 Location Range: IE__
$9,642.00 $13,714.00
$5,850.00 $15,065.00
$10,024.00 $18,389.00| |

Choosing a location for the sparkline

5. Click OK. The sparkline will appear in the document.
7. Click and drag the fill handle downward.

Dragging the fill handle

8. Sparklines will be created for the remaining rows.
ep O
$8,237.00  $8,690.00| ~——"
$10,185.00 $18,749.00) ——~_
$13,452.00 $8,046.00) "
$4,404.00 $20,114.00) — 7
$3,170.00 $10,732.00) — "~
$8,817.00 $18,524.00) —
$13,090.00 $13,953.00) —"
$3,528.00 $15,275.00) —
$4,830.00 $13,085.00) —
$9,642.00 $13,714.00) —

The finished sparklines

Changing the Appearance of Your Sparklines
To Change the Style:

1. Select the sparklines that you want to change.
2. Locate the Style group in the Design tab. y

.
3. Click the More drop-down arrow to show all of the available styles.

& Sparkline Color = 3P_

\/\/‘ ‘/\/\ \/\/‘ \/\/\ - [ Marker Color -
Style 'Ih J A

.
More

.

F G H | Choose avisual style for the
selected sparkline group. .

Bio £ O —
.

Viewing all of the available styles

4. Select the desired style.
VAN NAN N AN A :
WA ;

Selecting a sparkline style y

5. The sparklines will update to show the selected style.

The new sparkline style
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EXCEL WITH MS-EXCEL

To Change the Sparkline Type:
1. Select the sparklines that you want to change.
2  Locate the Type group in the Design tab.

3. Select the desired type (Column, for example).

— | t— — High Paint

k o hll. L 1]

Low Point

El Megative Points

ype Show

Line |Column | ‘Win/Loss

H2 Convert to Column Sparkline

Change the selected sparkline

“ group to a column sparkline,
Converting the sparkline type to
Column

4. The sparkline will update to reflect the new type.
Jm_=-_EN

The converted sparklines

Changing the Display Range

By default, each sparkline is scaled to fit the maximum and minimum values of its own data. This allows it to fill the
entire cell no matter how high or low the values are. However, it has a downside: If you are trying to compare
several sparklines, you won't be able to tell at a glance which ones have higher or lower values. The solution is to

make the display range the same for all of the sparklines.

To Change the Display Range:
1. Select the sparklines that you want to change.

2. In the Design tab, click the Axis command. A drop-down menu will appear.

3. Under Vertical Axis Minimum Value Options and Vertical Axis Maximum Value Options, select Same

for All Sparklines.

olor - i E Group

or- % E] Ungroup
Atls <2 Clear

| Horizontal Axis Options

|| ¥ | General Axis Type

Date Axis Type...

Show Axis
Plot Data Right-to-Left

Vertical Axis Minimum Value Options
Automatic for Each Sparkline

I v Same for All Sparklines '

Custom Value...

Vertical Axis Maximum Value Options

Automatic for Each Sparkline

I v Same for All Sparklines !

Custom Value..,

Changing the range of the
sparklines

4. The sparklines will update to reflect the new range.

The updated sparklines

FINJOB
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CTRL+1
CTRL+2
CTRL+3
CTRL+4
CTRL+5
CTRL+6&

CTRL+8&
CTRL+S
CTRL+0
CTRL+A

CTRL+B
CTRL+C

CTRL+D

CTRL+F

CTRL+G

CTRL+H
CTRL+I

EXCEL WITH MS-EXCEL

EXCEL SHORTCUTS

Displays the Format Cells dialog box
Applies or removes bold formatting.
Applies or removes italic formatting.
Applies or removes underlining.

Applies or removes strikethrough.

Alternates between hiding objects, displaying objects, and displaying placeholders for
objects.

Displays or hides the outline symbaols.
Hides the selected rows.
Hides the selected columns.

Selects the entire worksheet.

If the worksheet contains data, CTRL+A selects the current region. Pressing CTRL+A a

second time selects the current region and its summary rows. Pressing CTRL+A a third time
selects the entire worksheet,

When the insertion point is to the right of a function name in a formula, displays the
Function Arguments dialog box.

CTRL+SHIFT+A inserts the argument names and parentheses when the insertion point is
to the right of a function name in a formula.

Applies or removes bold formatting.

Copies the selected cells.

CTRL+C followed by another CTRL+C displays the Clipboard.

Uses the Fill Down command to copy the contents and format of the topmost cell of a
selected range into the cells below.

Displays the Find and Replace dialog box, with the Find tab selected.

SHIFT+F5 also displays this tab, while SHIFT+F4 repeats the last Find action.
CTRL+SHIFT+F opens the Format Cells dialog box with the Font tab selected.

Displays the Go To dialog box

F5 also displays this dialog box.

Displays the Find and Replace dialog box, with the Replace tab selected.

Applies or removes italic formatting.

FINJOB
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1. Bajaj Auto - The Bajaj
Group is amongst the top 10
business houses in India. Its
footprint stretches over a
wide range of industries,
spanning automobiles (two-
wheelers and three-
BAJAJ wheelers), home appliances,
lighting, iron and steel, insur-

ance, travel and finance. The group's flagship compa-
ny, Bajaj Auto, is ranked as the world's fourth largest
two- and three- wheeler manufacturer and the Bajaj
brand is well-known across several countries in Latin

America, Africa, Middle East, South and South East
Asia.

¢ Founded— November 29, 1945
¢ Founder— Jamnalal Bajaj

# Headquarters— Pune, Maharashtra, India

2. Micromax -
Micromax Informatics
Limited is one of the
leading consumer elec-
tronics company in
India and the 11th larg-
est mobile phone play-
er in the world. Over
the past decade, Micro-
max has pioneered the democratization of technology in
India by offering affordable innovations through their
product offerings and removing barriers for large scale
adoption of advanced technologies.

Cromax

notfing Ik anything

Micromax is currently the 2nd largest smartphone com-
pany in India with a market share of 19.2 percent in Q2
of 2013. The brand's product portfolio embraces more
than 60 models today, ranging from feature rich, dual -
SIM phones, 3G Android smartphones, tablets, LED
televisions and data cards.

¢ Founded— 1999
¢ Founders— Rahul Sharma, Sumeet Arora, Vikas Jain

¢ Headquarter— Gurgaon, Haryana, India

MIND

3. Linked in - Founded in 2003, LinkedIn connects
the world's professionals to make them more productive
and successful. With more than 259 million members
worldwide, including executives from every Fortune
500 company, LinkedIn is the world's largest profes-
sional network on
the Internet. The
company has a
diversified  busi-
ness model with
revenue  coming
from Talent Solu-
tions, Marketing
Solutions and Premium Subscriptions products. Head-

quartered in Silicon Valley, LinkedIn has offices across
the globe.

Specialties

#Online Professional Network, Jobs, People Search,
Company Search, Address Book, Advertising, Profes-
sional Identity, Group Collaboration

¢ Founded— March, 2006

¢ Founder— Evan Williams, Noah Glass, Jack Dorsey,
Biz Stone

¢ Headquarters— San Francisco, CA, U.S.A

4. Wipro - Wipro In-
fotech is a leading manu-
of computer
hardware and provider of
IT services in India and
the Middle East region.
Part of Wipro Ltd, the
$6.98 billion conglomer-
ate and global leader in
technology enabled solutions, the company leverages
on the parent's philosophy of 'Applying Thought' to
enable business results by being a transformation cata-
lyst.

facturer

WIPRO

Applying Thought

¢ Founded— 1945, India
¢ Founder— M. H. Premyji

¢ Headquarters— Bangalore, Karnataka, India
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FINCOURSE

Financial Markets : A Beginner’s Module

Currency Derivatives : A Beginner’s Module

This is a basic level programme for those who wish to
either begin a career in the financial markets in India or
simply learn the fundamentals of capital markets. The
course is structured to help understand the basic concepts
relating to different avenues of investment, the primary
and the secondary market, the derivatives market and fi-
nancial statement analysis.

This module has been designed with a view to improve
awareness about the 'Currency Derivatives' product,
which has been made available for trading in the Indian
securities market in 2009. The course content is struc-
tured to help a beginner understand what the product is,
how it is traded and what uses it can be put to.

Why should one take this course?
Why should one take this course?

® To understand the fundamentals of the currency
® To get a basic understanding of the products, players i market.
and functioning of financial markets, particularly the

capital market. ® To understand the currency futures as a risk man-

agement tool.
® To understand the terms

and jargons used in the fi-

nancial newspapers and peri-
odicals.

® To learn about the trading plat-
form of the currency derivatives seg-
ment of a stock exchange.

Who will benefit from this
course?

Who will benefit from this course?

®  Students
®  Students

® Teachers
® Teachers

® Bankers
Investors

e Corporate Executives
Employees of BPOs/IT Companies

e  Employees of Export/Import Houses
Employees of Brokers/Sub-Brokers

®  Analysts
Housewives

e  Employees of Brokers and Sub-brokers
Anybody having interest in the Indian securities mar-

® Anybody having interest in the Indian Securities
Market

Test details

Duration: 120 minutes Test details

No. of questions: 60 Duration: 120 minutes

Maximum marks: 100, Passing marks: 50 (50%); There is No. of questions: 60

no negative marking in this module.

Maximum marks: 100, Passing marks: 50 (50%); There

. o . . is no negative marking in this module.
Certificate validity: For successful candidates, certificates & &

are valid for 5 years from the test date. Certificate validity: For successful candidates, certifi-

cates are valid for 5 years from the test date.

FINJOB
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: UPCOMING COMPETITIVE EXAMS

P e e e e s .
I ARS Exam 2014

ARS Exam 2014 - Agricultural Research Services acronym as ARS Exam is conducted by the
I ASRB of Indian

Council of Agricultural Research (ICAR) for appointment as Scientists in Agricultutal Research
| Service (ARS)

Of Indian Council of Agricultural Research in the pay scale of Rs. 15,600 - Rs, 39,100 plus re-
I search Grade Pay of Rs. 6,000 in the ICAR (Indian Council of Agricultural Research) Institutes.

ARS Exam Eligibility
| Eligibility Criteria

1. Educational Qualification

I For Agricultural Research Service Test a candidate must have a Master’s degree or equivalent in the concerned subject.
2. Age

A candidate must have attained the age of 21 years but not have attained the age of 32 years as on the respective year of the
exam.

On job candidates of ICAR less than 45 years in age but not State Agricultural Universities less than 35 years in age as on the
respective year will also be eligible to appear subject to prossession of prescribed qualifications.
ARS Exam Pattern

ARS Exam consists of two stages i.e Preliminary Exam followed by Main Exam and Vice Voca as given below.
Preliminary Exam

Subject Type of Questions = M.Marks | Timming

Respective Professional Subject | Objective Type 150 2Hrs p p Iy o

Main Exam

Main Exam consists of three parts as given below:

. . No of -
Subject = Type of Questions . M.Marks | Timming
Questions

Very short answer type of i 10
PatA i e of quesfion=< 40 80

words

Short Answer type of question 1or 2
PattE 20 100

paragraph 3 Hrs.
PaC Essay type or discriptive type [ 60

Total 240

Note: Answers are required to be written in the space provided below the question. In no case
extra sheets will be provided

ARS Exam Fee

Prospective candidates have to pay Rs. 480 Plus registration charge of Rs. 20/-
ARS Exam Dates

ARS Prilimary Exam is generally held in the month of February every year.
ARS Exam Contact Details
The Secretary

Agricultural Scientists Recruitment Board krishi Anusandhan Bhavan Pusa, New Delhi— 110012
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Online Marketing job description Responsibilities

Online Marking professionals are required to
combine their efforts with other areas such as 8 ¢Plan and execute all web, SEO/SEM, mar-
technical support, creative services, and sales [ keting databa}se, email,h social media and dis-
in order to plan and execute marketing cam- [ play advertising campaigns

paigns. They are responsible for the use of ' ' o ' )
marketing strategies on internet and mobile il ®Design, build and maintain our social media
devices. These professionals can manage a 8 presence

Twitter or Facebook profile in the name of a
company, publishing new content and news
related to that business on a daily basis in or-
der to obtain new clients.

eMeasure and report performance of all digital
marketing campaigns, and assess against
goals (ROI and KPIs)

eldentify trends and insights, and op-
timize spend and performance based
on the insights

Online Marketing

professionals usually per-
form some of the following
tasks:

y dream
job is...

eBrainstorm new and creative growth
strategies

* Creating and sending

email campaigns. ePlan, execute, and measure experi-

* Optimizing web content ments and conversion tests
for SEO strategies. , o

(¥} eCollaborate with internal teams to
create landing pages and optimize

user experience

» Updating social media
profiles.

. Advising about new trends.
* Managing the development and launch of
display advertisements.

Requirements

Skills

» Having good written and spoken communi-
cation abilities.

e BS/MS degree in marketing or a related
field

e X+ years of experience in digital market-
ing ;

* Being self motivated and flexible.

* Having critical thinking. e Demonstrable experience leading and .

managing SEO/SEM, marketing database,
email, social media and/or display advertising
campaigns

* Being independent.

* Being able to work on several projects at the
same time.

e Highly creative with experience in identi-
fying target audiences and devising digital
campaigns that engage, inform and motivate. .

 Having high attention to details.
* Having teamwork skills.
» Having networking abilities.

* Being able to understand social media.
* Having problem solving skills.



III. The deposit insurance facility of the Deposit Insurance and
Credit Guarantee Corporation is not available for NBFC deposi-
tors.

Which among the above Statement(s) is/are not correct ?
A.OnlyI B.Tand Il
C. All of them D. None of them

1. Which among the following is the oldest Public Sector
Bank of India ?

A. Punjab National Bank

ANSWERS OF NOW | WINNER OF FINjJOB
IT’S YOUR TURN OF
FINJOB 15

B. Imperial Bank of India
C. Allahabad Bank

D. Central Bank of india .
1) Option-D

2) Option - A
3) Option-B

2. Which among the following Public Sector Undertaking
(PSUs) is the ‘fifth’ company which has been accorded the
‘Mabharatna’ status ?

A. Coal India Limited (CIL)

B. Gas Authority of India Limitted (GAIL)
C. Power Grid Corporation of India Limited
D. Bharat Heavy Electricals Limited (BHEL)

NOTE:- Send your solution of ‘Now it’s your turn-
1’ to the following email-id. The first two persons

3. Consider the following Statements regarding Non-Banking [l who will give the correct solution, their name with
Finance Institutions (NBFCs) : their photographs will be published in the next issue.

1. NBFCs can also engage in Micro-Finance Activities financeclub@its.edu.in

II. Housing-finance companies from a distinct sub-group of il I aviprasad@its.edu.in
the NBFCs.

N

Send us your feedback and

suggestion at: EDITORS:
financeclub@its.edu.in Pooja Singh
manjulamba@its.edu.in .
poojasingh.ds@its.edu.in Ravi Prasad
raviprasad@its.edu.in

Disclaimer:

FINVEST which symbolize finance and invest-| (| of interview tips, fincourse, dream job, etc.

ment is a student managed club and it aims to| ||from various sources (newspapers, websites,

. journals and magazines) and hence, no personal
spread knowledge to all those who aspire to| [Ianalysis is being done by the members. Thus,

learn the Nitti gritty of Finance. The uniqueness| ||readers are expected to cross-check the facts
. g 'ty f : g before relying upon them. Though much care
about this club is its focus on practical aspects of| |[ has been taken to present the facts without er-

; ror, still if errors creep in, necessary feed backs
finance and regular research by students which will always be welcomed. Editors would not be

|

|

[

|

|

|

|

|

This newsletter is just a compilation of contents I
|

|

|

|

|

|

keeps them updated with the changing scenario. responsible for any undertakings. |
|
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